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This file details all program enhancements and revisions. 
 

For the most recent changes, scroll to the end of the file. 
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Quikbeam release 1.00                                           08-12-99 
 

The installation disk contains the following program releases: 

 Quikbeam  release 1.00 

 Install.exe  release 3.10 

 Uninstal.exe  release 2.21 

 Quiknet.exe  release 1.01 

 DC.exe   release 1.00 

 

This is the first official release of Quikbeam. It is fully functional and ready for sales. 

Quikbeam (Like Merlin and Quik5950) comes in two versions: 

 16 bit for Windows 3.11 

 32 bit for Windows '95, '98, NT and 2000 

 

Separate delivery disks are supplied for each version, the disk should be clearly marked. Make sure you have 
the right one. 
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Quikbeam release 1.01                                        17-01-00 
 

The installation disk contains the following program releases: 

 Quikbeam.exe  release 1.01 
 Install.exe  release 3.10 
 Uninstal.exe  release 2.21 
 Quiknet.exe  release 1.01 
 DC.exe   release 1.00 

  

The changes are: 

1. During lateral torsional buckling checks for I, C and Tee sections, the printed results now give more 
intermediate values; in particular values of u and v. QB R1.01-01 

2. Composite beams, final stage. The deflection diagrams showed a value for deflection based on the inertia 
of the non-composite beam. This is fixed. The diagrams now account for the inertia of the composite 
beam (uncracked) and include additional shear deflection due to partial shear connection. See 6.1.4. 

3. Composite beams, final stage. Deflection limits were always assumed to be applied to unfactored live and 
never unfactored dead. That is to say that the program always used its default settings. This is corrected. 
QB R1.01-02 

4. Composite beams, final stage, deflections. Both the summary and the detailed calculations have 
additional text to explain how the total deflection is determined and how pre cambering may be used to 
counter the affects of dead load deflection. QB R1.01-03 

5. Composite beams, Error 13701 fixed. During Composite design's shear capacity check, Quikbeam was 
using the most positive value of shear instead of numerically largest. That is to say, if the largest value 
was negative, it would be ignored. This fault also had the effect (where shear ought to have been zero) of 
producing small negative residual values, these were the cause of the 13701 error. QB R1.01-04 

6. Some users were unsure of which tab was selected in the form's Construction/Final stage tab bar. A check 
mark is now added. QB R1.01-05 

7. Complaints about the Input Wizard - Loads form being crowded are resolved. The bottom right of the 
form now sports an arrow. Click on it and the form is made larger. QB R1.01-06 

8. In release 1.00, if a beam was fully input including loads, then attempting to reduce its span would 
produce a warning message advising that the loads/restraints should be changed first. This was unhelpful, 
particularly when engineers were using the File|Save as option to produce a similar beam, but of different 
span. Quikbeam now traps span changes and issues the following message: Span has changed. Quikbeam 
will adjust the start and finish dimensions for all loads and restraints. You should check that these 
adjustments are correct. QB R1.01-07 
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Quikbeam release 1.02                                                  11-02-00 
 

The installation disk contains the following program releases: 

 Quikbeam.exe  release 1.02 

 Install.exe  release 3.10 

 Uninstal.exe  release 2.21 

 Quiknet.exe  release 1.03 

 DC.exe   release 1.00 

  

The changes are: 

1. The diagram that showed the LT buckling lengths, displayed the depth factor without decimal places, so 
0.5D was displayed as 0D. This is corrected. QB R1.02-01 

2. The Supports form is modified. When designing with cantilevers the form introduces cantilever tabs and 
modifies the prompt to request input from the relevant table. This change both clarifies and improves the 
calculation of effective length factors, particularly where cantilevers are involved.  

Table 13 of BS5950 states that for cantilevers without intermediate restraints m and n should be taken as 
one. This rule was ignored in the previous version. Quikbeam now interprets this rule as follows: for the 
last unrestrained length away from the cantilever tip, Quikbeam uses the effective length factor taken 
from table 10 with m and n=1.00. All other lengths, including lengths between restraints on cantilevers, 
will use the rules for beams. QB R1.02-02 

3. Quikbeam's calculated value of Mb for single unequal angles, was flawed based on a poor interpretation 
of the BS. BS5950 Section 4.3.8 Page 31 gives some simple formulae 

e.g. Mb = 0.7 Py.Z  

It states: Z is the smaller elastic modulus about the appropriate axis. Quikbeam used to calculate the Z as 
the minimum of Zx and Zy (Safe). Of course it overlooked the fact that there is actually a minimum and 
maximum value of both Zx and Zy and that that was the meaning of smaller. Fixed. QB R1.02-03 

4. Output is enhanced. At the head of the calculations, where Quikbeam states the selected section and 
grade, it now adds the section orientation: Bending about x-x axis; or Bending about y-y axis. QB R1.02-
04 

5. Where a structural, tee bending about the y-y axis, had an Iy greater than Ix, Quikbeam, performed 
erroneous lateral buckling checks. LT buckling in Tees bending like this are not covered in BS5950, or by 
Quikbeam. Under these circumstances, Quikbeam now calculates a large value for LambdaLT which 
ensures the section fails. QB R1.02-05 

6. Two new options: Modify|Check; Modify|Design. Both display a short version of the corresponding 
Wizard and provide a faster and more convenient method of returning and trying different sections.  QB 
R1.02-06 

7. For composite beams, the Check Wizard - Result form now has Shear Stud and Transverse shear buttons.   
QB R1.02-06 

8. Right clicking in Quikbeam's Window now displays a pop-up menu. The pop-up menu contains the same 
options as the Modify menu. QB R1.02-06 

9. Future major release upgrades of Quikbeam (Moving from 1.02 to 2.00) will now require the user to input 
an upgrade code. The upgrade code will be supplied by the dealer. QB R1.02-07 

10. The following applies to composite beam's only. For dead load deflection at final stage, Quikbeam 
produced a deflection based on the total final stage dead load for the uncracked composite section. This 
was not correct. The program now calculates the deflection based on the additional dead load at final 
stage. The construction stage dead load deflection is then added to produce the total which is published in 
the summary and detailed calculations. The deflection diagram, both on-screen and in the results is also 
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modified to show the reduced value. Finally, the title displayed with the diagram for the final stage 
deflection now reads: Deflection due to additional dead load. QB R1.02-08 

11. The pop-up menu in the loads input form now has a new: Delete all loads option. QB R1.02-09 

12. The following fault manifested itself in the sixteen bit version only: start Quikbeam; open an existing file; 
close Quikbeam; EGPFault displaying message general protection fault in module QUIKBEAM.EXE at 
002F:1342. Fixed. QB R1.02-10 

13. The Loads - Append supported beam reactions form is modified: if the user closes the form with the 
distance field as zero, the form now asks for confirmation. QB R1.02-11 

14. On line help is upgraded to cover the above changes. 
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Quikbeam release 1.10                                            16-06-00 
 

The installation disk contains the following program releases: 

 Quikbeam.exe  release 1.10 

 Install.exe  release 4.00 

 Uninstal.exe  release 3.00 

 Quiknet.exe  release 1.03 

 DC.exe   release 1.00 

  

The changes are: 

1. ASB, Plated I sections (SFB) and Gantry girders added to Brit.sec in line with similar changes to Merlin. 
New sections files supplied ASTM.sec (American sections to ASTM specifications) and Japanese.sec 
(Japanese wide flange shapes).  Parallel flange channels (PFC) are now included in Brit.sec. Users 
upgrading from earlier versions of Quikbeam should select the new option File|Sections and delete the 
old sections file PFC.sec. (see item 2). Failure to delete PFC.sec will cause Quikbeam to list each PFC 
twice. QB R1.03-01  

2. Option File|Sections added. This new option displays a list of the available sections files. You may select 
a file and either: display its properties (Type, version, description, author, organisation and read-only); or 
delete the sections file from the current installation of Quikbeam.  QB R1.03-16 

3. Quikbeam is now supplied with more comprehensive and up to date steel deck, concrete and stud files: 
Quikbeam.dec; Quikbeam.con; Quikbeam.stu. User's upgrading who have defined there own decks, 
concretes, or studs should note down their additions/changes prior to installing the new version of 
Quikbeam. QB R1.03-18 

4. Because Quikbeam now deals with asymmetric sections, additional logic has been added to decide the 
compression flange and properly determine its flange classification and value of N for the calculation of 
'v' used in lateral torsional buckling calculations. QB R1.03-02 

5. Quikbeam's Select section form, accessed in Check Wizard and through the Check option on the 
Modify/Popup menu is improved. The Axis drop down list box is removed, instead the program draws the 
cross section shape and supplies an orientation button. Each click on the orientation button (or section 
diagram) rotates the section ninety degrees. An invalid orientation e.g. an ASB bending about its y axis, 
can't be selected. QB R1.03-07 

6. Again the Select section form. If user entered the Select section form with no section selected, then 
clicked on the serial size list box, dragged the mouse out, and released the button an error 30001 would 
occur. Fixed.   QB R1.03-05 

7. Extra logic is added so that Quikbeam can store Merlin's sections and properly deal with the changes in 
data structure that occur with different versions of Merlin and or Quikbeam. QB R1.03-06 

8. Quikbeam's Options|Font dialog now offers only TruType fonts. Non-TrueTypes don't rotate reliably, this 
may have been the cause of the following reported fault: Access Violation 00489ac6. Also see     item 14. 
QB R1.03-08 

9. Within the Loads form, the Append supported beam reaction and Append floor loads options could both 
append loads with zero intensity. This caused Quikbeam to flag an input error prior to design/checking. 
This is fixed:- zero loads are no longer appended.  

Also: both these options will automatically add restraints due to the floor slab or supported beam. 
However, it used to be possible by repeated use, to obtain many restraints in the same place. Quikbeam 
now checks for a previous restraint, if it finds one it modifies it, otherwise it adds the new one.                
QB R1.03-09 

10. Project manager's Backup, Restore, Copy and Delete options are overhauled to include checking and 
messages for all types of disk error (including out of space!).  QB R1.03-10 
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11. The File|Project manager|Options option now permits the selection of either: backup to a removable 
drive (Zip and CD-R's included); or backup to a remote drive (across a network). See on-line help.                 
QB R1.03-11 

12. The File|Project manager|Create form is changed to include the project title. The project title can now be 
entered without having to select File|Project manager|Title. The form that selects projects in the: Backup; 
Restore and Delete options, now displays the title for the selected project. QB R1.03-12  

13. Quikbeam's results now show a diagram immediately before the calculation summary. The diagram 
shows the selected section in its selected orientation. QB R1.03-13 

14. The following fault manifested itself in the 32 bit version only: start Quikbeam use File|Open and select 
B1, use File|Open again and select B2. Closing either file caused an access violation with a Read of 
address error. QB R1.03-14  

15. In composite construction, if the user entered final loads that were less than the construction stage loads, 
fc could be negative causing the program to crash with a 13701 error. This is fixed, plus in summary of 
results, Quikbeam displays the comment: fc<0.0 check loading. QB R1.03-15  

16. Web openings: prior to viewing the calculations, Quikbeam now checks all openings for compliance with 
the guidelines in Section 9 (p20) of the guide. If the openings do not conform the program shows a 
warning dialog containing a 'Show warning next time' check box, and a Help button leading to context 
sensitive help explaining the problem. QB R1.03-17 

17. Bison slabs are added to deck, concrete and stud tables. See example beam design Bison.qb installed in 
project NoProj.   QB  R1.03-19   

18. The composite and stud forms accessed from the Input Wizard and Modify menu now have buttons that 
access the forms for adding custom decks, concretes and studs. QB  R1.03-20  

19. The Decks, Concretes and Studs forms accessed under the File menu have the following bug fixed. No 
matter how the tables were changed. The number of items would remain the same.  QB  R1.03-21   

20. In the printed output, some of the formulas for the composite moment capacity were wrong in that the 
squared term had shifted. This did not effect the calculated results. 

21. Composite design: during detailed output for the transverse shear check, to make checking easier, 
Quikbeam now prints more results. QB  R1.03-22 QB  

22. Bison recommend that when designing with their hollow core floors the plastic neutral axis should never 
be higher than 50mm above the top flange of the steel beam. Quikbeam has been modified so that this 
information is readily available:- The summary of results output now includes the position of the plastic 
neutral axis. If the axis is in the concrete, the program states its position down from the top. QB  R1.03-23 

23. Clause 5.4.5.4 Large concrete flanges of BS5950:Part 3:Section 2 defines a large concrete flange in terms 
of the composite beam having a moment of resistance greater than 2.5 times that of the steel beam alone. 
In determining the composite moment of resistance, Quikbeam now assumes the beam to have a full shear 
connection. Beams having 'Large concrete flanges' are subject to an intermediate capacity check in 
accordance with 5.4.5.5 Alternative method. as a consequence, more beams will be subjected to an 
intermediate check than would previously have been the case. QB  R1.03-24  

24. The Decks, Concretes and Studs forms accessed from the File menu and used to define custom decks, 
concretes and studs now have a Return to defaults button. Pressing this button, first asks for confirmation, 
then re-sets the table to Quikbeam's delivery content. QB  R1.03-25  

25. On-Line help is extended and improved. 
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Quikbeam release 2.00                                        15-03-01 
 

This release of Quikbeam operates in accordance with BS5950:Part 1:2000. 

Quikbeam is supplied in self-extracting zip files:- 

For Windows ’95 ’98 NT and 2000: 

QB-32-200.exe 

QB-32-del.exe 

For Windows 3.1: 

QB-16-200.exe 

QB-16-del.exe 

If you are supplying on disk, rename the first file INSTALL.EXE and the second UNINSTAL.EXE 

The self extracting files contain the following program releases: 

 Quikbeam.exe release 2.00 

 Install.exe  release 4.00 

 Uninstal.exe  release 3.00 

 Quiknet.exe  release 1.03 

If you are installing on a network you should obtain: Quiksoft for Windows Network supplement. 

1. Much of Quikbeam is rewritten to operate in accordance with the amended BS5950:Part 1:2000. All 
capacity, classification, LT buckling, combined bending checks have been rewritten and the program 
output reworked. QB  R2.00-01 

2. Cold formed hollow sections added (CF-CHS, CF-SHS and CF-RHS). CHS, SHS and RHS become HF-
CHS, HF-SHS and HF-RHS.  QB  R2.00-01 

3. This release of Quikbeam will require the user to enter a release code. A major release is when the first 
digit changes so: upgrading from release 1.12 to 2.00 will require a dealer supplied code; upgrading from 
2.00 to 2.11 will not.  QB  R1.02-07  

4. A slight glitch could happen when sections were defined using Merlin. If a new tee section was defined in 
Merlin of type 'Tee' as opposed to 'TEE' and then exported it could not be selected in Quikbeam. The 
problem was to do with upper or lower case letters. When Quikbeam built the list of section types it 
compared Tee with TEE and said they were the same, so did not add it to the section type list. When 
Quikbeam built the serial list it compared Tee with TEE and said they were different, so the section serial 
did not get added. Fixed. QB  R2.00-02 

5. There was an access violation problem associated with Quikbeam’s 123 form. Because of programing 
inconsistencies when displaying the progress box, it was possible to get two Quikbeam 123 forms running 
at the same time. This caused subsequent problems. QB  R2.00-03  

6. Changing the file description or other header information whilst the results were displayed failed to 
update the screen. Fixed. QB  R2.00-04 

7. Selecting File|DXF resulted in an error 12909 caused by the addition of the Options|Sizes option. Fixed. 
QB  R2.00-05 

8. Selecting File|DXF when results were selected gave an error 32005. The File|DXF and File|DXF Setup 
options are now disabled when results are displayed. QB  R2.00-06 

9. Results output for compound sections now include: Comprising:- with a list of the component materials. 
QB  R2.00-07  

10. Ward Multideck80 1.2 was listed as being 81 mm deep. The default tables have been changed to 80 mm 
deep to stay within the deck dimensions laid out in BS5950:Part 3:Section 3.1 clause 5.4.7.1(a): The 
overall depth of the profiled sheet should be not less than 35mm nor greater than 80mm. QB  R2.00-08 
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11. Existing users should select the File|Decks option and either change the depth of the Multideck80 to 80.0, 
or click on the Return to defaults button. Note if the return to defaults button is used any additional decks 
added by the user will be lost. 

12. An error due to the addition of the Headings tab for Merlin in the File|Paper setup option occurred. This 
is fixed. QB  R2.00-10  

13. Printing results. If more than one copy was selected, Quik5950, Quikbeam and Merlin could produce too 
much output. The fault was dependant on version 16bit/32bit operating system and printer driver, so not 
all users will have found it. Q5  R2.00-12  

14. The operation of the Load case and Combinations forms are improved and simplified. These forms are 
now by-passed during composite design. Composite design can use the default load cases Dead and 
Imposed only (as before). For normal simple steel design, load cases and combinations can be altered 
freely at any time. If a load case is edited, deleted or inserted the combinations and loads will be 
automatically updated. QB  R2.00-14  

15. The Construction type form has new code to ensure that a simple beam with non-standard load cases or 
combinations is not changed to Composite. QB  R2.00-14 

16. The On-line help is uprated and improved. 
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Quikbeam release 2.10                                        03-10-02 
 

Quikbeam is supplied in self-extracting zip files:- 

For Windows ’95 ’98 NT 2000, XP: 

QB-32-210.exe  for installation 

QB-32-del.exe for un-install 

Windows 3.11 is no longer supported 

The self extracting files contain the following program releases: 

• Quikbeam.exe release 2.10 

• Install.exe release 4.00 

• Uninstal.exe release 3.00 

• Quiknet.exe release 1.03 

If you are installing on a network you should obtain: Quiksoft for Windows Network supplement. 

1. This version of Quikbeam was produced using a more modern compiler (Delphi 7). Some minor code 
changes were required. QB  R2.01-07 

2. When designing with angles, QuikBeam could produce either an ‘Invalid floating point’, or ‘attempt to 
assign to a nil pointer’ error. Fixed. QB  R2.01-01 

3. 3. When inputting loads, Quikbeam looks at the data and ensures that the values are within a prescribed 
range. The maximum value for point and distributed loads was too small and has been increased.            
QB  R2.01-02 

4. During validation of user input, Quikbeam checks that distances are less than the beam length. However 
because of the vagaries of computers and real numbers, if the actual beam length was entered, Quikbeam 
could wrongly flag an error. QB  R2.01-02 

5. When the Edit|Copy for Quikjoint option is used a form is displayed. The form still used the 'old' steel 
grade designation (Grade 43, 50, 55). Fixed. QB  R2.01-03 

6. Quikbeam's File|Project manager|Backup option makes a special check to ensure that floppy disks are 
present in the drive before it starts copying files. Unfortunately the check was flawed and the program 
failed to accept completely blank disks. Disks with one or more directory, file, or disk label were fine. 
Fixed. QB  R2.01-04 

7. Angles must have their Mx moment resolved into moments about the angles principal axes (Mu and Mv). 
The code that did this was flawed in that it took no account of the angles orientation. Fixed. QB  R2.01-05 

8. Angles - the output refers to clause J.4.2. It should have read I.4.2. Fixed. QB  R2.01-06 

9. The code that calculated the effective area Aeff of channel sections contained a fault. Users may like to 
know that they could never have encountered this fault since all Quiksoft programs design slender 
channels by reducing Py. They do not use effective properties for channels. QB  R2.01-08 

10. A fault was found in the Restraints - Change form. The form left some data un-initialised which 
sometimes caused a crash when the form was closed. Fixed. All forms in Quikbeam have been checked 
and a similar fault repaired in the Loads - Change form. It is thought unlikely that this fault would have 
affected the correct operation of the program. QB  R2.01-09 

11. Part of the output for lateral torsional buckling of angles was missing. Fixed. QB  R2.01-10 

 The new BS5950 - 2000 standard replaced m and u with mLT. Along with the rewrite of this part of the 
standard, the requirement that for asymmetric sections mLT etc. be taken as one, was removed from the 
text. At this point in time it is not absolutely clear if this was intentional. We think it is correct to use non-
unity values for asymmetric sections (including angles). However until the situation is clarified Quikbeam 
and Quik5950 will be using values of 1.00. QB  R2.01-11 

For left hand cantilevers the calculations showed the beam deflection limit instead of the cantilever limit. 
The calculations were correct. Fixed. QB  R2.01-12 
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12. Due to a fault, the calculated deflections for the tips of cantilevers (most likely a left cantilever), could be 
wrong. This is corrected. QB  R2.01-12  
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Quikbeam release 2.11                                                           05-11-02 
 

Quikbeam is supplied in self-extracting zip files:- 

For Windows ’95 ’98 NT 2000, XP: 

QB-32-211.exe  for installation 

QB-32-del.exe for un-install 

Windows 3.11 is no longer supported 

The self extracting files contain the following program releases: 

• Quikbeam.exe release 2.11 

• Install.exe  release 4.00 

• Uninstal.exe release 3.00 

• Quiknet.exe release 1.03 

 

The changes in this release are as follows: 

1. Release 2.10 was produced using a more modern compiler (Delphi 7). Release 2.10 of Quikbeam went 
with Delphi’s new default of eight byte reals.  

2. For loading and storing Quikbeam data files it converted back to six byte reals, however this caused 
problems when comparing numbers. 

3. Quikbeam release 2.11 has returned to using the old six byte real numbers. QB  R2.11-03 
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Quikbeam release 3.00                                                                       21-11-07 
 

Quikbeam release 3.00 runs under all versions of Windows from ’95 to Vista and is supplied in a single self 
extracting file: QB32-300.exe. This self extracting file contains a Setup program that will automatically guide 
you through program installation upgrade, removal and registration. 

See: Program installation, upgrade and removal in the Quikbeam User’s Guide. 

The changes to Quikbeam are as follows: 

1. Quikbeam and its setup program are now fully Microsoft Vista compliant. Under Vista the Setup program 
will automatically elevate and request an administrator password. Under Windows XP the Setup program 
should be run with administrator privileges. See: Program installation, upgrade and removal in the 
Quikbeam User’s Guide. 

2. The Setup program is now used to unlock licensed and demonstration copies. 

3. Program logic has been moved from Quikbeam to its setup program enabling Quikbeam to operate under 
a standard user account in both Windows XP and Vista. {Vista} 

4. Prior to this release, changes to the decking, concrete and stud tables were stored in the program 
directory. This is not permitted under either Microsoft Vista or XP when running with reduced privileges. 
Quikbeam is now modified so that any changes are stored with the user’s project in a folder called 
‘Quiksoft data’. See On-line help. {Vista}  

5. Quikbeam’s user interface (speed button spacings) are tidied in keeping with the other Quiksoft 
programs. 

6. The Edit|Copy from Quikjoint options are modified so that they operate under Vista. Please note that 
under Microsoft Vista and Windows XP with reduced privileges this will require a new Quikjoint release. 
All other situations should operate correctly as before. {Vista} 

7. The File|DXF options now accepts file names greater than eight characters in length.  {Vista} 

8. There could be a problem operating Quikbeam under languages other than English. Most European 
language settings use a comma instead of a full stop as a decimal separator. This caused the Windows 
routines that perform decimal conversion to view the decimal point ‘.’ as an error, causing Quikbeam to 
crash at start-up. Now Quikbeam always uses a full stop as a decimal separator overriding the Windows 
settings. This is not a perfect solution for European users, but at this stage is considered the most robust. 
Also see next item. QF R7.40-05  

9. Quikbeam now accepts a ‘,’ as keyboard input for a decimal separator. Internally the program converts 
this to a decimal point ‘.’. QF R7.40-08 

10. Quikbeam's File menu now sports a Reopen option. The File|Reopen option is used to open recently used 
files. QB  R3.00-01 

11. A Send option is added to Quikbeam’s File menu. This new option will attach the current beam file to an 
outgoing e-mail message. QB  R3.00-02 

12. Quikbeam’s scrolling calculations windows are replaced with the newer versions shared by the other 
Quiksoft programs. These enable the text to be searched, saved, copied to other programs (Copy and 
Paste) and sent via e-mail. 

13. Quikbeam's table of steel decks is updated. QB  R3.00-04 

14. The Composite form now includes a note that manufactures info must be consulted and asks the user to 
reference the help system. QB  R3.00-05 

15. A possible error 13105 is fixed. The error occurred when viewing the deflection diagram for a beam with 
two cantilevers. QB  R3.00-03  

16. A possible error that could affect Quikbeam's installation is fixed. Where the program compares drive 
letters it failed to raise both to uppercase before the comparison. Fixed. QB  R3.00-06 

17. Quikbeam’s on-line help system is now based upon compiled HTML rather than WinHelp2.0 which is no 
longer supported under Vista.  



 Quikbeam User’s Guide 

Page 14 of 30 
 

18. Quikbeam’s Help is extended to cover it’s new features, including up to date manufactures contact details 
and links to technical details on the world wide web. 
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Quikbeam release 4.00                                                   14-05-10 
 

Quikbeam release 4.00 runs under all versions of Windows from ’95 to Windows 7 and is supplied in a single 
self extracting file: QB32-400.exe. This self extracting file contains a Setup program that will automatically 
guide you through program installation upgrade, removal and registration. 

See: Program installation, upgrade and removal in the Quikbeam User’s Guide. 

The changes to Quikbeam are as follows: 

1. Quikbeam now includes design to Eurocode (EN 1993-1-1:2005 and EN 1994-1-1:2004). QB  R3.01-03 

2. A new option is added to the Help menu: Purchase design modules. After installation or upgrading you 
must use this option to unlock the BS5950/Eurocode design modules. QB  R3.01-05  

3. Quikbeam's composite beam design is modified to incorporate changes required by BS5950-
3.1:1990+A1:2010. QB  R3.01-01, QB  R3.01-04 

4. Changes to composite design as recommended by AD 266. QB  R3.01-02 

5. Modifications to the On-line help system to incorporate the above changes. QB  R3.01-06 
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Quikbeam release 4.01                                                                       27-05-10 
 

Quikbeam release 4.01 runs under all versions of Windows from ’95 to Windows 7 and is supplied in a single 
self extracting file: QB32-401.exe. This self extracting file contains a Setup program that will automatically 
guide you through program installation upgrade, removal and registration. 

See: Program installation, upgrade and removal in the Quikbeam User’s Guide. 

The changes to Quikbeam are as follows: 

1. Quikbeam now shows the currently selected national annex in it's title bar: Quikbeam - National annex: 
UK - [Demo1]. QS  Cap-01   

2. A New menu option is added: Options|Results options providing easy access to the Results options form. 
This form contains a new Eurocode tab where the current national annex settings can be output in the 
printed results. Note that the Results options form was formerly the Calculation options form.               
QB  Cap-02 

3. The PageUp/PageDown keys now work in the results preview. QB  R4.00-01 

4. Starting Quikbeam by double clicking on it's data file resulted in an error: 11106. Fixed. QB  R4.00-02 

5. Error 32003 is fixed. This was due to spans or cantilevers being less the 0.100 metres. The limit is now 
reduced to 0.025 metres and the spans form now properly validates and produces a message preventing 
input that could cause an error. QB  R4.00-03 

6. Release 4.00 implemented the reduced stud capacities of BS5950-3.1:1990+A1:2010. However on longer 
spans with deep open trapezoidal decks the existing check for the degree of shear connection proved to 
restrictive. This new release includes additional logic to implement the new rules for higher ductility 
shear connectors (5.5.2.3a). When these rules are applied the program includes a note at the head of the 
calculations including a reference to 5.4.7.1 which details where these new rules are applicable.              
QB  R4.00-04 

7. The On-line help and manual are updated. 



 Quikbeam User’s Guide 

Page 17 of 30 
 

Quikbeam release 4.02                                                                       04-06-10 
 

Quikbeam release 4.02 runs under all versions of Windows from ’95 to Windows 7 and is supplied in a single 
self extracting file: QB32-402.exe. This self extracting file contains a Setup program that will automatically 
guide you through program installation upgrade, removal and registration. 

See: Program installation, upgrade and removal in the Quikbeam User’s Guide. 

The changes to Quikbeam are as follows: 

1. On occasions Quiksoft programs have encountered errors reading sections files. These have been due to 
poor versioning or user error and usually take the form of a message: Attempt to load unregistered 
ClassID=????. The programs are now modified so that the error message contains a path to the offending 
file. QB  R4.01-01 
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Quikbeam release 4.10                                                                       07-07-11 
 

Quikbeam release 4.10 runs under all versions of Windows from ’95 to Windows 7 and is supplied in a single 
self extracting file: QB32-410.exe. This self extracting file contains a Setup program that will automatically 
guide you through program installation upgrade, removal and registration. 

See: Program installation, upgrade and removal in the Quikbeam User’s Guide. 

The changes to Quikbeam are as follows: 

1. The following additional options are now added to the Help menu: 

a. Visit the Quiksoft website: This option opens the Quiksoft home page on the web. 

b. Check for latest updates: This option displays a 'Check for latest updates' form. The form will 
connect to the Quiksoft website and advise if program updates are available. QS-WS-1 

2. The Quiksoft programs have encountered problems with compiled HTML help systems (.chm files) 
running over networks due to Microsoft enforced security issues. The recent release of Internet Explorer 
9 has made the situation even worse. Hence at start-up the program will now copy the entire help file 
from the server to a temporary folder on the client. The help system is then run locally. This should 
resolve all known HTML help issues. QS-HLP-1 

3. Upgrading to a new release will now require a code when the digit immediately after the decimal changes 
e.g. Upgrading from 7.01 to 7.09 will not require an upgrade code. Upgrading from 7.09 to 7.10 will 
require a code. This does mean that release codes will be required more frequently, but better fits our 
release strategies since the effected releases often contain considerable enhancement. QS-UPG-1 

4. After installation, unlocking Quikbeam with a demo code will now automatically unlock all design 
modules (Eurocode and BS5950). Design modules must still be unlocked in full purchased versions.     
QB R4.01-01  
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Quikbeam release 4.20                                                                                   18-07-12 
 

Quikbeam release 4.20 runs under all versions of Windows from XP onwards and is supplied in a single self 
extracting file: QB32-420.exe. This self extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/quiksoftdownloads 

The changes to Quikbeam are as follows: 

1. Support for operating systems older than Windows XP is now withdrawn. 

2. Modifications to enhance software security. QS-23-08-11 QS-18-10-11-1 

3. The Changes detailed for release 4.10 item 3 where flawed. Fixed. QS-26-08-11-1 QF R8.21-01 QS-04-
11-11-1 

4. The Quiksoft programs show the currently selected national annex on their main window caption. 
However, where the national annex had not been selected the programs showed a blank. Now before a 
national annex is selected the caption shows 'National annex: Box' and until a new national annex is 
selected the Box values will be used in any Eurocode calculations. QS-26-08-11-2 QS-18-10-11-2 

5. Value of Alphacc for the UK national annex for EN 1992-1-1 was taken as 1.00 but should have been 
0.85. Also typo in National Annex change form corrected. Note that this value is not used by any program 
other than Quikjoint. QS-14-12-01-1 QJ R7.40-53 

6. All Quiksoft executable downloads and applications are now digitally signed using Microsoft 
Authenticode. For additional security the Quiksoft applications now check that the signature is intact and 
that the executables have not been altered or corrupted. QS-11-04-12-1 

7. Quikbeam's Help|About form now displays the file signature status. QS-11-04-12-1 

8. All Quiksoft executables now have extended manifest files. The WinZipSE program that we use to 
produce the self extracting installation file is updated to release 4.0. These changes should avoid the 
message: 'This program might not have installed correctly' after installation. QS-23-04-12-1 QS-23-04-12-
2 

9. Changes to network licensing to simplify deletion of logged on users. On start up, networked copies of 
the Quiksoft programs count the number of copies already in use (logged on users). If these exceed the 
number of concurrent licences a warning is produced, however from time to time because of system 
crashes users could remain logged on. This can be repaired by rerunning the Setup program and selecting 
Network server tools and Log off users.  

However, now the problem can be fixed more directly from within each application by selecting a new 
'Log off users' button displayed within the Licence error form. 'Log off users' now produces a report 
showing each file deletion. QS-25-04-12-3 

10. The default name and address for new users used to be loaded from Quiksoft.ini in the user's Windows 
folder. Quiksoft.ini is a legacy 16bit windows file and will no longer be used. The default user name and 
address is now obtained from the program source code. QS-27-04-12-4    

11. The Quiksoft Setup program no longer copies Quiksoft.ini into the user's Windows folder. This file was 
used by the old 16bit Quiksoft programs, which are no longer supported. QS-27-04-12-5 

12. The Quiksoft logo displayed by the Setup program is modernised. QS-27-04-12-6 QS-02-05-12-8 

13. The Quiksoft logo displayed in Quikbeam's introduction form is modernised.                                         
QS-27-04-12-7 QS-02-05-12-8 

14. When first run, before the user's project folder was set, the Quiksoft programs sometimes created an 
empty folder: c:\quiksoft data\quikbeam. Fixed. QS-08-05-12-9 

15. The Quiksoft Setup program is extensively modified to automate network installations. QS-18-06-12-01 
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16. On startup, if the licence folder is missing the Quiksoft programs now issue an error: License folder: 
<Path> is missing'. Prior to this they would report: 'There is a copy of Quik??? already running'.        
QS-18-06-12-02 

17. The section in the manual and on-line help covering program installation is removed and replaced with a 
link to the Quiksoft web site QS-18-06-12-03 
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Quikbeam release 4.21                                                                                   26-06-13 
 

Quikbeam release 4.21 runs under all versions of Windows from XP onwards and is supplied in a single self 
extracting file: QB32-421.exe. This self extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/quiksoftdownloads 

1. The changes to Quikbeam are as follows: 

2. The Help|About form is modfied with more detailed text, plus a link to the Quiksoft web site.                     
QS-08-11-12-01 

3. The Quiksoft programs have an option to list the values of the selected National annex. Unfortunately, the 
values for the 'Box' national annex were displayed incorrectly. Note this affected the display of the Box 
national annex values only, all calculations were correct. QS-05-06-13-01 
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Quikbeam release 4.30                                                                                   17-12-13 
 

Quikbeam release 4.30 runs under all versions of Windows from XP onwards and is supplied in a single self 
extracting file: QB32-430.exe. This self extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/quiksoftdownloads 

The changes to Quikbeam are as follows: 

1. Quikbeam's handling of projects in modernised. Quikbeam now includes the option for existing users to 
switch to a new method of handling project folders. Existing users should select the menu option: 
File|Project manager|Adopt new file handling. New users will automatically be given the new file 
handling. See Quikbeam's Help system. QS-09-10-13-02 QS-09-10-13-04 

2. When New file handling is selected, the headings for the printed output are modified:- 

a. The current project is removed. 

b. The box for the file name permits a longer file name. QS-09-10-13-03 

3. The printed output for the Quiksoft programs now includes the full path to the data file printed just 
outside the margin. QS-12-08-13-01  

4. The Help|Purchase design modules option no longer requires restarting Quikbeam using 'Run as 
Administrator...' QS-25-10-13-01 QS-30-10-13-02 

5. The Help|Purchase design modules form is updated and improved. QS-30-10-13-05 

6. The Quiksoft programs no longer require to be unlocked by the Setup program. Instead unlock codes are 
requested at program start-up. QS-29-10-13-01 QS-21-11-13-03 

7. The program's introduction form displayed for demonstration copies is generally improved and now 
includes number of days remaining. QS-25-11-13-05 

8. All options to do with registration including major releases are removed from the Setup program. These 
are now performed at program start-up. QS-30-10-13-01 QS-05-11-13-02 

9. For network copies Quikbeam's Help menu now includes a 'Network licence settings' option. The new 
option covers administration options for concurent network copies. QS-30-10-13-03 QS-30-10-13-04 

10. The Quiksoft installation copied Setup.exe into each applications program folder. On network server 
installations this could be started to quickly perform a setup on a client computer. Unfortunately many 
users were confusing it with the full Setup program. It is now more correctly named 'ClientSetup.exe'. 
QS-05-11-13-01 QS-05-11-13-03 QS-08-11-13-04 

11. The Quiksoft program's Browse For Folder form was found to be unreliable when browsing deep 
directory structures on a network server. It is replaced with the standard windows form. QS-08-11-13-05 

12. The Quiksoft setup program's network client setup in improved. It now includes a Search button to find 
the Quiksoft program on the server. QS-19-11-13-01 

13. The project manager options under the old file handling has a Backup, Restore and Copy option. The 
progress bar is improved cosmetically. QS-02-12-13-02 

14. The Project manager|Floor loadings menu option displays the The Floor loadings form containing a 
Same as button. When new folder handling is selected, Quikbeam's response to pressing this button is re-
coded with a new Select project folder form. QB R4.21-01 

15. Edits and updates for Quikbeam's help content. QS-21-11-13-02 QS-21-11-13-04 
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Quikbeam release 4.31                                                                                   11-08-14 
 

Quikbeam release 4.31 runs under all versions of Windows from XP onwards and is supplied in a single self 
extracting file: QB32-431.exe. This self extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal 

The changes to Quikbeam are as follows: 

1. Eurocode steel design - Using Method 1 for the calculations of kij factors for combined buckling, the 
formula taken from Table A.2 of EN1993-1-1 (case 2) for Cmi,0 was presented wrongly as '1.0(' rather than 
'1.0 +'. Note the actual calculations performed were correct, only the representation of the formula in the 
on screen and printed output were wrong. QS-15-05-14-03 

2. The new project handling contained a fault. The project title was not always updated properly. Fixed.         
QS-20-12-13-03 

3. For demonstration copies the days remaining in the program's introduction form could be displayed 
incorrectly. Fixed. QS-08-01-14-04 

4. The Quiksoft Help|About form now displays the Quiksoft logo. QS-12-05-14-01 

5. The Quiksoft Introduction form for unregistered and demonstration copies now displays the latest 
Quiksoft banner logo. QS-21-05-14-04 QS-12-05-14-02 

6. The Quiksoft Setup program now uses the new Quiksoft banner logo. QS-21-05-14-04 

7. Quikport's manual is updated. 
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Quikbeam release 5.00                                                                                   27-05-16 
 

Quikbeam release 5.00 runs under all versions of Windows from XP (SP3) onwards and is supplied in a 
single self extracting file: QB32-5.00.exe. This self extracting file contains a Setup program that will 
automatically guide you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal 

The changes to Quikbeam are as follows: 

1. Following the publication of ‘P355: SCI: Design of composite beams with large web openings’, 
Quikbeam now offers a choice for the Eurocode checks for web openings of using either:  SN019b-EN-
EU or P355. QB R5.00-01  

2. Quikbeam now implements the rules for partial shear connection for both/either: ‘PN002a - NCCI: 
Modified limitation on partial shear connection in beams for buildings’ or ‘SCI publication P405 - 
Minimum degree of shear connection rules for UK construction to Eurocode 4’. Check and Design wizard 
now have additional forms where these options can be chosen. QB R5.00-02    

3. There was a problem in the handling of the Eurocode national annexes. The programs stored the currently 
selected national annex in the registry in a location used by all of the programs. However the actual data 
files were stored in a separate location for each member of the Quiksoft family. e.g. 
‘....\Quiksoft\Quikbeam\UK.na3’. This was illogical. Each program now stores it current national annex 
separately. This makes it possible to be working in QuikEC3 using say BOX values and at the same time 
having Quikbeam open using ’UK’ values. The default national annex is now ‘UK’. QS-16-01-15-01 

4. The form displayed when the ‘Help|Check for latest updates’ menu option is selected is modified. The 
form now directs the user to upgrade instructions on the revised Quiksoft web site. QS-19-03-15-01 

5. This release includes a National Annex for Singapore (SS). QS-23-04-15-01 

6. As of April 18, 2012 all Quiksoft executable downloads have been digitally signed using Microsoft 
Authenticode. This ensures that the downloaded files originate from us and have not been altered; 
reducing operating system and browser warnings associated with downloads. 

As of May 27, 2016 new software releases will be signed using a more advanced system. The name on 
the certificate is now ‘Quiksoft Limited’. Downloads should have immediate good reputation using 
Microsoft’s Explorer and Edge browser, but others may take a little time before downloads are easily 
accepted without warnings. QS-27-05-16-03 

7. Quikbeam’s help and manual are updated. QB R5.00-03 
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Quikbeam release 5.01                                                                                   26-01-17 
 

Quikbeam release 5.01 runs under all versions of Windows from XP (SP3) onwards and is supplied in a 
single self extracting file: QB32-5.01.exe. This self extracting file contains a Setup program that will 
automatically guide you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal 

The changes to Quikbeam are as follows: 

1. The additional features in release 5.00 added to cover ‘P355: SCI: Design of composite beams with large 
web openings’ contained a fault. The checks on the placement of the opening according to the rules of 
P355 Table 2.1 could wrongly produce a warning that it was too close to a point load.  QB R5.01-01 
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Quikbeam release 5.02                                                                                   19-05-17 
 

Quikbeam release 5.02 runs under all versions of Windows from XP (SP3) onwards and is supplied in a 
single self extracting file: QB32-5.02.exe. This self extracting file contains a Setup program that will 
automatically guide you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal 

The changes to Quikbeam are as follows: 

1. Design to Eurocode now offers the option of using the combination of actions described in equations 
(6.10a) and (6.10b) of EN 1990 rather as well as (6.10). Note that when using this new option it is the 
designer’s responsibility to ensure that (6.10b) does not govern. QB R5.02-02 

2. There was a slight problem when saving new Quikbeam data files. The current project folder was 
sometimes not offered as the default folder. Fixed. QB R5.02-01   

3. Modern project handling - When selecting a project folder, if the folder does not exist, Quikport now asks 
the engineer if he wants to create it. QS-15-02-17-01  QP R7.50-10 

4. Quikport's 'Headers details' form used to select, among other things, the first sheet number for the printed 
output now performs additional data validation.  QS-17-02-17-02  QP R7.50-12 

5. The form that controls the contents of the headers in the printed output  (Options|Results headers) now 
includes a new check box 'Show file path in margin'.  QS-04-04-17-03   
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Quikbeam release 5.03                                                                                   05-06-17 
 

Quikbeam release 5.03 runs under all versions of Windows from XP (SP3) onwards and is supplied in a 
single self extracting file: QB32-5.03.exe. This self extracting file contains a Setup program that will 
automatically guide you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal 

The changes to Quikbeam are as follows: 

1. Release 5.02 of Quikbeam revealed a fault. The fault actually existed in all releases back to 4.00. If the 
design method was switched from BS to Eurocode, Quikbeam would 'forget' any deflection limits added 
by the user. In release 5.02 the routine that did this was called more frequently, the fault was therefore 
more persistent. Fixed. QB R5.03-01    
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Quikbeam release 6.00                                                         09-07-2020 
 

Quikbeam release 6.00 runs under all versions of Windows from XP onwards and is supplied in a single self-
extracting file: QB32-600.exe. This self-extracting file contains a Setup program that will automatically guide 
you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal  

 

1. Quikbeam’s opening window now includes a ‘Print’ icon giving fast access to the ‘File|Project 
manager|Print project’ option where all beams in the current project can be printed in a single 
document complete with index, summary and floor loading. 

2. When checking impossibly high transverse shear to Eurocode, Quikbeam could loop and become 
unresponsive. Fixed. QB R6.00-01   

3. Eurocode holes in webs (P355) - There was a small glitch in the implementation of Table 2.1 in P355. 
The check for the Minimum width of web post with high shear was using the value 0.5ho. Now 
correctly uses 0.4. QB R6.00-02 

4. Eurocode holes in webs (P355) - The code that checks the minimum width of the web post against 
Table 2.1 of P355 contained a fault. Fixed. QB R6.00-03   

5. When the 'Reactions' tab is selected the diagram now shows all web openings. QB R6.00-04 

6. Holes in web - Eurocode – (P355) - The web posts of non-composite beams were not previously 
checked. Quikbeam now uses the method of P355 modified to suite. QB R6.00-05 

7. Holes in web - Eurocode – (P355) - Quikbeam produces a warning based upon the limit described in 
P355 5.2.2 Page 64. Unfortunately, the check was incorrect. Fixed. QB R6.00-06 

8. Eurocode holes in webs (P355) - AD420 has clarified the use of minimum values of shear and 
moment (Table 3.1 of P355). Quikbeam is modified to suite and the switch in the 'P355 settings' form 
is removed. QB R6.00-07  

9. Eurocode holes in webs (P355) - A warning triggered by Table 2.1 in P355 is softened. It was being 
triggered when ‘ht’ and ‘hb’ were approximately equal. QB R6.00-08 

10. New project handling - The form where the project folder and program data folder are selected now 
validates that the folders have write and create file permissions.  QS-20-09-17-01 

11. Quikbeam's 'File Open' and 'File Save as' forms are now sizable.  

12. Project handling - On rare occasions users were experiencing problems when their selected project 
folder became invalid. It can become invalid after changes using Windows file explorer (renaming, 
moving, or changes to folder access permissions). The project folder and program data folder are now 
checked just after program start-up. If the Quiksoft programs detect a problem, they display a warning 
with a ‘Help’ button that will give information and a remedy. QS-10-10-17-01 

13. Prior to registering as a fully licenced copy the Quiksoft programs display an introduction form. The 
forms main function is to accept codes to unlock the software. This form now displays the program 
release number. QS-26-01-18-01, QS-12-12-18-01   

14. The customer name and address default is now Quiksoft Limited with contact details.                      
QS-19-07-18-01 

15. The introduction form for trial copies now includes a link to the 'Buy now' page of the Quiksoft 
website, displayed only when the remaining free trial days falls below seven. The same form now 
includes better advice (hint text) on how to copy and paste the serial number to email. The popup 
menu is also improved. QS-19-11-18-01   

16. Quikbeam now automatically checks the Quiksoft website to see if updates are available on start-up. 
The check is made every other time the software is started. If updates are available a form is 
displayed with access to a direct download link and full instructions. There is also a Snooze option. 
QS-07-03-19-01 
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17. The existing form ‘Check for latest updates’ available from the ‘Help’ menu is uprated to give access 
to the same direct download link and instructions. The form also provides an option to turn the 
automatic check off. QS-07-03-19-01 

18. When a file is opened that is not in the current project, a new form is displayed asking if the user 
wants to change the current project folder. The new form is displayed when the Quikbeam data file is 
opened in any of these ways: 

a) From ‘File|Open’ on the main form’s menu. 
b) From the ‘File Open’ icon on the main form. 
c) From the ‘File|Reopen’ option on the main form. 
d) From the 'Open recent beam file' option in the 'Quick start' form displayed at program start-up 

or when the Quiksoft logo is clicked. 
e) When a Quikbeam beam file is opened with a double click from file explorer. 

Note that the new form will not be displayed in any of these circumstances: 

a) When the program is still using 'old style' file handling. 
b) When there is already a Quikbeam file open. 
c) When the file to be opened is on the desktop. 
d) When the file does not have a containing folder. 
e) When the containing file can't be written to. 

QS-23-04-19-01  

19. DXF Output - The form that requested a file name is replaced with the standard Windows ‘File save’ 
form. The file can now be saved in any location with any name. QS-05-06-19-01 

20. File handling routines are modified to handle file names containing '.'. Over the years file naming 
convention has changed. It was originally assumed that file names would only contain a single '.' and 
that all characters after would be the file extension. However, this seems no longer to be the case. 
That said we would still advise that as far as possible this be avoided. It is likely that it could cause 
problems when transferring files to other programs and operating systems. We have found here that 
servers that use Unix derivatives (NAS drives, Android, Apache etc.) have differing standards. We 
have also tested using a folder path containing '.' mimicking an IP address with no problems detected.                                           
QS-05-06-19-02 

21. It is possible to use the scroll wheel to zoom in and out of the diagram. The convention now seems to 
be that if the wheel is rotated forward the diagram gets bigger. The Quiksoft programs are modified to 
conform. QS-05-06-19-03 

22. Dual monitor systems - When running on the second monitor Quikbeam could display some forms on 
the primary monitor. Fixed. QS-05-04-19-01, QS-08-04-19-01 

23. Additional code is added to detect when a form is displayed 'off screen' and move it back to a visible 
area. Because the Quiksoft programs 'remember' some window and form positions, they could have 
previously been displayed on a second monitor that has been disconnected. This caused the form to 
be displayed 'off screen' leading customers (and us!) to believe the program had become 
unresponsive. On the occasions this was reported it involved the scrolling calculations form in 
Quikjoint. Fixed. QS-08-04-19-01 

24. Quikbeam now includes the option to use your company logo in place of your address text on the 
printed output. See the 'Addresses' option available on the 'File' menu, and via right clicking on the 
results preview page and selecting 'Results headers' on the popup menu.  QS-27-07-19-01 

25. Quikbeam’s on-line help and manual are updated. 
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Quikbeam release 6.50                                                04-04-2023 
 

Quikbeam release 6.50 runs under all versions of Windows from XP onwards including Windows 10 and 11 
and is supplied in a single self-extracting file: QB32-650.exe. This self-extracting file contains a Setup 
program that will automatically guide you through program installation, upgrade, removal, and registration. 

Instructions for program installation, upgrade and removal are available on the Quiksoft web site: 
www.quiksoft.co.uk/installation-upgrade-and-removal  

The changes to Quikbeam are as follows: 

1. Quikbeam is now supplied with an updated ‘Advance.sec’ sections file with additional sections from 
British Steel. QS-08-11-22-02   

2. On start-up and from within the ‘Help’ menu, Quikbeam contacts the Quiksoft website to check for new 
releases and provides links and help text to facilitate easy upgrades. The text now advises contacting 
support@sigma-x.net. QS-08-11-22-03   

3. Quikbeam will now print in colour. The default remains black and white, but this can be changed using 
the 'Paper setup' option on the 'File' menu. Note that the option is not available until a file is open.        
QS-29-11-22-04   

4. Quikbeam’s default colours are changed. We have added colour printing and some colours, namely 
yellow, are too light on a white paper background. If you are choosing to print in colour, visit the 'Colour 
and styles' menu item on the 'Options' menu and select 'Return to defaults'. This will select the new 
default Quiksoft colour scheme. QB R6.01-01 

5. Modifications to the ‘Setup’ program to fix a Windows 10/11 fault in the operation of 'Add or Remove 
programs'. QS-18-01-23-06   

6. Corresponding modifications to the Quiksoft ‘Uninstall’ program. The ‘Uninstall’ program now simply 
shows a message advising that program removal be carried out via the original setup program.              
QS-18-01-23-07   

7. The form displayed when 'About' is selected on the 'Help' menu is improved (cosmetic). QS-20-01-23-08 

8. Steel design to Eurocode Clause 6.33 and 6.34 - Where axial is low it can be ignored, and we use NRd 
rather than the reduced value. Unfortunately, Quikframe was reporting NEd. Now corrected to NRd. Note 
that the calculations were correct. QB R6.01-04 

9. On rare occasions, Quikbeam's checks for openings in webs in accordance with EC4/P355 could produce 
an 'Invalid floating point operation' message. The fault occurred during section classification of the 
bottom tee when stressed to full capacity resulting in a square root of a negative number. Fixed. QB 
R6.01-02  

10. The Floor load and beam load forms have had text added to make doubly sure that the designer is aware 
that all dead loads including slab and deck must be entered. Quikbeam does not automatically add any 
dead loads. The help system is also updated. QB R6.01-03 

11. Quikbeam’s help system and manual are updated to cover colour printing. 

 

 

 


